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Table: Gantt chart for Final Year Project I 

NO MONTH JULY AUGUST SEPTEMBER OCTOBER NOVEMBER 
 DETAIL 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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2. 

 
PRELIMINARY PROJECT 
RESEARCH 
- Background study of project 
- Identify problem statement 
- Identify objectives 
- Literature review 

              

 
 
 
3. 

 
PROJECT WORK 
- Determine ASTM standard 
-  Determine empirical 
expression 
-  Familiarize with ANSYS 
-  Modeling specimen in 
ANSYS 

              

 
 
 
4. 

 
SUBMISSION 
- Preliminary report 
- Progress report 
- Seminar 
- Interim report 
- Oral presentation 
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Table: Gantt chart for Final Year Project II 

N
O 

MONTH JAN FEBRUARY MARCH APRIL MAY 

 DETAIL 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 
 
1. 

 
EVALUATION OF FYP I 
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2. 

 
PROJECT WORK CONTINUE 
- Design graph of Stress Intensity 
Factor vs ௔

ௐ
 from 0.45 to 0.55 

-Design graph of Stress Intensity 
Factor vs ௐ

஻
 from 2.0 to 4.0 

              

 
 
 
3. 

 
ANALYSES 
- Analyses result and further 

recommendation of the project 

              

 
 
 
4. 

 
SUBMISSION 
-  Progress Report I 
-  Progress Report II 
-  Seminar 
-  Poster Submission 
-  Dissertation (Soft bound) 
-  Oral Presentation 
-  Dissertation (Hardbound) 
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In order to using KCALC command for plane strain analysis. Several steps and 

procedures must be followed in order to conduct the analysis. The steps are as follows: 

1. Preprocessing 

a. Give the jobname for the analysis 

i. Utility menu > File > Change Jobname. Insert jobname 

b. Define element type 

i. Main Menu > Preprocessor > Element Type > 

Add/Edit/Delete 

ii. Select PLANE2 and SOLID95  

 

Figure 1.1: Selecting Element Types 

iii. Click Options and select Plane Strain  

 

Figure 1.2: Plane element type options 



xii 
 

c. Define material properties 

i. Main Menu > Preprocessor > Material Props > Material 

Models 

ii. Structural > Linear > Elastic > Isotropic 

iii.  Insert the material properties of Young Modulus (EX) and 

Poisson’s Ratio (PRXY) 

 

Figure 1.3: Material Properties 

d. Define key points 

i. Main Menu > Preprocessor > Modeling > Create > Keypoints 

> In Active CS 

 

Figure 1.4: Creating key-points by coordinate  

ii. Insert key-points coordinate according to the model 

e. Create the Area 

i. Main Menu > Preprocessor > Modeling > Create > Areas > 

Arbitrary > through KP > pick > OK 
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f. Create circle 

i. Main Menu > Preprocessor > modeling > create > areas > 

circle > solid circle 

ii. Insert radius, x and y coordinate 

iii. Main menu > Preprocessor > modeling > operate > Booleans 

> Subtract > areas > pick all > pick circle 

g. Meshing the Area 

i. Main Menu > Preprocessor > Meshing > Size Cntrls > 

Concentrated KPs.  > create > OK 

ii. Pick  crack tip key-point. Fill appropriate value. Click OK 

iii. Main  menu > Preprocessor > meshing > manual sizes > lines 

> pick lines  > OK 

 

 

 

Figure 1.5: Meshed Areas 

i. Choose every line at the model 

ii. Main Menu > Preprocessor > Meshing > Mesh > Areas > 

Free 

iii. Select the area to be meshed. Click OK 
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h. Extrude the model 

i. Main Menu > Preprocessor > Modeling > Operate > Extrude 

> Element Ext Opts 

 

Figure 1.6: Element extrusion option 

ii. Put No of element division and spacing ratio 

iii. Main Menu > Preprocessor > Modeling > Operate > Extrude 

> Areas > by xyz offset > Ok 

iv. Put thickness value. Click OK 

2. Solution 

a. Define  boundary condition 

i. Utility menu > select > select everything > select entities > 

area > by numpick > apply 
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ii. Main Menu > Solution > Define Loads > Apply > Structural >  

displacement > symmetry boundary condition > on nodes > 

pick all 

iii. Insert Y axis = 0 then click OK 

iv. Main menu >  Solution > define loads apply > structural > 

displacement > lines > pick lines > OK 

v. Set DOF = 0 

vi. To see the boundary condition at that line use plot lines   

 

                        Figure 1.7: Boundary condition on nodes 

 

 

Figure 1.8: Displacement value is set for 0 for all DOF 
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b. Define load 

i. Utility menu > select > select entities >  ares  > by numpick > 

apply 

ii. Choose area at the top of the circle 

iii. Utility menu > select > select entities > nodes > attached to > 

area, all > apply 

iv. Main Menu > Solution > Define Loads > Apply > Structural >  

Force/Moment  > > on nodes > pick all >  OK 

v. Set the applied load equal to applied load divide by the no of 

nodes 

 

 
 

Figure1.9: Applied load to the area selected 

 

c. Solve 

i. Main  menu > solution > solve > Current LS > OK 

3. General Postprocessor 

a. Plot result 

i. Main menu > General Postproc > Plot result > Contour plot > 

nodal solution >  Von Stress Misses > OK 

b. Define Path 
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i. Main menu > General Postproc > Define Path > By nodes 

ii. Select 3 nodes of crack from the crack tip to the direction of 

crack. Click OK. 

iii. Set Path = K1 

 

 

 

 

 

 

Figure 1.10: Select nodes at crack tip which is in the direction 

from crack tip to the crack 

 

Figure 1.11: Define pathname of the path 

c. Define Stress Intensity Factor, K 

i. General Postproc > Nodal Calc > Stress Intensity Factor > OK 
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ii. The result will appear 

 

Figure 1.12: Stress intensity factor KCALC results 
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Table 4.1: K  value for ࢇ
ࢃ

 ratio from 0.45 to 0.49 for empirical method 

W/B B (m) 0.45 0.46 0.47 0.48 0.49 

2.00 0.0250 1.4919 1.5348 1.5796 1.6261 1.6762 

2.10 0.0238 1.5665 1.6116 1.6585 1.7074 1.7600 

2.20 0.0227 1.6411 1.6883 1.7375 1.7887 1.8438 

2.30 0.0217 1.7157 1.7651 1.8165 1.8700 1.9276 

2.40 0.0208 1.7903 1.8418 1.8955 1.9513 2.0114 

2.50 0.0200 1.8649 1.9185 1.9744 2.0326 2.0952 

2.60 0.0192 1.9395 1.9953 2.0534 2.1139 2.1790 

2.70 0.0185 2.0141 2.0720 2.1324 2.1952 2.2628 

2.80 0.0179 2.0887 2.1488 2.2114 2.2765 2.3466 

2.90 0.0172 2.1633 2.2255 2.2904 2.3578 2.4304 

3.00 0.0167 2.2379 2.3023 2.3693 2.4391 2.5142 

3.10 0.0161 2.3125 2.3790 2.4483 2.5204 2.5980 

3.20 0.0156 2.3870 2.4557 2.5273 2.6017 2.6819 

3.30 0.0152 2.4616 2.5325 2.6063 2.6830 2.7657 

3.40 0.0147 2.5362 2.6092 2.6852 2.7643 2.8495 

3.50 0.0143 2.6108 2.6860 2.7642 2.8456 2.9333 

3.60 0.0139 2.6854 2.7627 2.8432 2.9269 3.0171 

3.70 0.0135 2.7600 2.8394 2.9222 3.0082 3.1009 

3.80 0.0132 2.8346 2.9162 3.0012 3.0895 3.1847 

3.90 0.0128 2.9092 2.9929 3.0801 3.1708 3.2685 

4.00 0.0125 2.9838 3.0697 3.1591 3.2521 3.3523 
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Table 4.2: K  value for ࢇ
ࢃ

 ratio from 0.45 to 0.49 for numerical method 

B W/B 0.45 0.46 0.47 0.48 0.49 

0.0250 2.00 1.6210 1.6670 1.7150 1.7650 1.8176 

0.0238 2.10 1.7027 1.7505 1.8006 1.8531 1.9083 

0.0227 2.20 1.7836 1.8337 1.8862 1.9444 1.9992 

0.0217 2.30 1.8644 1.9168 1.9717 2.0290 2.0899 

0.0208 2.40 1.9452 1.9999 2.0573 2.1174 2.1807 

0.0200 2.50 2.0259 2.0829 2.1427 2.2054 2.2713 

0.0192 2.60 2.1067 2.1660 2.2282 2.2934 2.3620 

0.0185 2.70 2.1874 2.2490 2.3136 2.3814 2.4526 

0.0179 2.80 2.2682 2.3321 2.3991 2.4694 2.5433 

0.0172 2.90 2.3489 2.4152 2.4846 2.5574 2.6340 

0.0167 3.00 2.4296 2.4976 2.5694 2.6448 2.7240 

0.0161 3.10 2.5103 2.5811 2.6554 2.7333 2.8152 

0.0156 3.20 2.5910 2.6641 2.7408 2.8212 2.9058 

0.0152 3.30 2.6716 2.7470 2.8261 2.9090 2.9963 

0.0147 3.40 2.7523 2.8300 2.9115 2.9970 3.0869 

0.0143 3.50 2.8330 2.9130 2.9969 3.0849 3.1775 

0.0139 3.60 2.9137 2.9960 3.0823 3.1756 3.2681 

0.0135 3.70 2.9943 3.0789 3.1676 3.2607 3.3586 

0.0132 3.80 3.0751 3.1620 3.2531 3.3488 3.4493 

0.0128 3.90 3.1557 3.2449 3.3385 3.4388 3.5398 

0.0125 4.00 3.2366 3.3281 3.4240 3.5247 3.6306 
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Table:  KI  value for ௔ 
௪

 ratio from 0.50 to 0.55 for empirical method 

B (m)  w/b  0.50 0.51 0.52 0.53 0.54  0.55

0.0250  2.00  1.7280 1.7817 1.8407 1.9016 1.9642  2.0321

0.0238  2.10  1.8144 1.8708 1.9328 1.9966 2.0624  2.1337

0.0227  2.20  1.9008 1.9599 2.0248 2.0917 2.1606  2.2354

0.0217  2.30  1.9872 2.0490 2.1168 2.1868 2.2588  2.3370

0.0208  2.40  2.0736 2.1380 2.2089 2.2819 2.3570  2.4386

0.0200  2.50  2.1600 2.2271 2.3009 2.3769 2.4552  2.5402

0.0192  2.60  2.2464 2.3162 2.3930 2.4720 2.5534  2.6418

0.0185  2.70  2.3328 2.4053 2.4850 2.5671 2.6516  2.7434

0.0179  2.80  2.4192 2.4944 2.5770 2.6622 2.7498  2.8450

0.0172  2.90  2.5056 2.5835 2.6691 2.7573 2.8480  2.9466

0.0167  3.00  2.5920 2.6725 2.7611 2.8523 2.9462  3.0482

0.0161  3.10  2.6785 2.7616 2.8531 2.9474 3.0445  3.1498

0.0156  3.20  2.7649 2.8507 2.9452 3.0425 3.1427  3.2514

0.0152  3.30  2.8513 2.9398 3.0372 3.1376 3.2409  3.3530

0.0147  3.40  2.9377 3.0289 3.1292 3.2326 3.3391  3.4546

0.0143  3.50  3.0241 3.1180 3.2213 3.3277 3.4373  3.5562

0.0139  3.60  3.1105 3.2071 3.3133 3.4228 3.5355  3.6578

0.0135  3.70  3.1969 3.2961 3.4054 3.5179 3.6337  3.7595

0.0132  3.80  3.2833 3.3852 3.4974 3.6129 3.7319  3.8611

0.0128  3.90  3.3697 3.4743 3.5894 3.7080 3.8301  3.9627

0.0125  4.00  3.4561 3.5634 3.6815 3.8031 3.9283  4.0643
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Table:  KI  value for ௔ 
௪

 ratio from 0.50 to 0.55 for numerical method 

B (m)  w/b  0.5 0.51 0.52 0.53 0.54  0.55

0.0250  2  1.8728 1.9311 1.9925 2.0574 2.1259  2.1987

0.0238  2.1  1.9664 2.0276 2.0922 2.1604 2.2324  2.309

0.0227  2.2  2.0601 2.1243 2.1919 2.2635 2.339  2.4193

0.0217  2.3  2.1536 2.2208 2.2916 2.3665 2.4455  2.5295

0.0208  2.4  2.2472 2.3173 2.3913 2.4695 2.552  2.6397

0.0200  2.5  2.3407 2.4138 2.4908 2.5724 2.6584  2.7499

0.0192  2.6  2.4341 2.5102 2.5904 2.6752 2.7648  2.86

0.0185  2.7  2.5276 2.6066 2.6899 2.7781 2.8712  2.9701

0.0179  2.8  2.6211 2.7031 2.7896 2.881 2.9776  3.0803

0.0172  2.9  2.7146 2.7995 2.8891 2.9839 3.084  3.1904

0.0167  3  2.8074 2.8953 2.988 3.0861 3.1896  3.2997

0.0161  3.1  2.9013 2.9922 3.0881 3.1895 3.2966  3.4104

0.0156  3.2  2.9947 3.0886 3.1876 3.2923 3.4029  3.5204

0.0152  3.3  3.088 3.1848 3.2869 3.395 3.509  3.6303

0.0147  3.4  3.1815 3.281 3.3865 3.4978 3.6154  3.7404

0.0143  3.5  3.2748 3.3775 3.4859 3.6006 3.7216  3.8503

0.0139  3.6  3.3683 3.4739 3.5854 3.7034 3.8279  3.9603

0.0135  3.7  3.4739 3.5702 3.6864 3.806 3.9341  4.0702

0.0132  3.8  3.5551 3.6666 3.7844 3.9089 4.0405  4.1803

0.0128  3.9  3.6484 3.7629 3.8838 4.0116 4.1467  4.2902

0.0125  4  3.7419 3.8594 3.9834 4.1146 4.2531  4.4004
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Table:  KI  value for ௕ 
௪

 ratio from 2.0  to 2.4 for empirical method 

a/w  A (m)  2 2.1 2.2 2.3  2.4 

0.45  0.0225 1.492 1.566 1.641 1.716  1.790 

0.46  0.023  1.535 1.612 1.688 1.765  1.842 

0.47  0.0235 1.580 1.659 1.738 1.816  1.895 

0.48  0.0240 1.626 1.707 1.789 1.870  1.951 

0.49  0.0245 1.676 1.760 1.844 1.928  2.011 

0.50  0.025  1.728 1.814 1.901 1.987  2.074 

0.51  0.0255 1.782 1.871 1.960 2.049  2.138 

0.52  0.0260 1.841 1.933 2.025 2.117  2.209 

0.53  0.0265 1.902 1.997 2.092 2.187  2.282 

0.54  0.027  1.964 2.062 2.161 2.259  2.357 

0.55  0.0275 2.032 2.134 2.235 2.337  2.439 

 

Table:  KI  value for ஻
௪

 ratio from 2.0  to 2.4 for numerical  method 

a/w  A (m)  2 2.1 2.2 2.3  2.4 

0.45  0.0225 1.621 1.703 1.784 1.864  1.945 

0.46  0.0230 1.667 1.751 1.834 1.917  2.000 

0.47  0.0235 1.715 1.801 1.886 1.972  2.057 

0.48  0.0240 1.765 1.853 1.944 2.029  2.117 

0.49  0.0245 1.818 1.908 1.999 2.090  2.181 

0.50  0.025  1.873 1.966 2.060 2.154  2.247 

0.51  0.0255 1.931 2.028 2.124 2.221  2.317 
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0.52  0.0260 1.993 2.092 2.192 2.292  2.391 

0.53  0.0265 2.057 2.160 2.264 2.367  2.470 

0.54  0.027  2.126 2.232 2.339 2.446  2.552 

0.55  0.0275 2.199 2.309 2.419 2.530  2.640 

 

Table:  KI  value for ஻ 
ௐ

 ratio from 2.5  to 2.9  for empirical method 

 

a/w  A (m)  2.5 2.6 2.7 2.8  2.9

0.45  0.0225 1.865 1.939 2.014 2.089  2.163

0.46  0.023 1.919 1.995 2.072 2.149  2.226

0.47  0.0235 1.974 2.053 2.132 2.211  2.290

0.48  0.0240 2.033 2.114 2.195 2.276  2.358

0.49  0.0245 2.095 2.179 2.263 2.347  2.430

0.50  0.025 2.160 2.246 2.333 2.419  2.506

0.51  0.0255 2.227 2.316 2.405 2.494  2.583

0.52  0.0260 2.301 2.393 2.485 2.577  2.669

0.53  0.0265 2.377 2.472 2.567 2.662  2.757

0.54  0.027 2.455 2.553 2.652 2.750  2.848

0.55  0.0275 2.540 2.642 2.743 2.845  2.947
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Table:  KI  value for ஻ 
ௐ

 ratio from 2.5  to 2.9  for numerical method 

a/w  A (m)  2.5 2.6 2.7 2.8  2.9 

0.45  0.0225 2.026 2.107 2.187 2.268  2.349 

0.46  0.023  2.083 2.166 2.249 2.332  2.415 

0.47  0.0235 2.143 2.228 2.314 2.399  2.485 

0.48  0.024  2.205 2.293 2.381 2.469  2.557 

0.49  0.0245 2.271 2.362 2.453 2.543  2.634 

0.50  0.025  2.341 2.434 2.528 2.621  2.715 

0.51  0.0255 2.414 2.510 2.607 2.703  2.800 

0.52  0.026  2.491 2.590 2.690 2.790  2.889 

0.53  0.0265 2.572 2.675 2.778 2.881  2.984 

0.54  0.027  2.658 2.765 2.871 2.978  3.084 

0.55  0.0275 2.750 2.860 2.970 3.080  3.190 

 

Table:  KI  value for ஻ 
ௐ

 ratio from 3.0  to 3.4  for empirical method 

a/w  A (m)  3 3.1 3.2 3.3  3.4 

0.45  0.0225 2.238 2.312 2.387 2.462  2.536 

0.46  0.023  2.302 2.379 2.456 2.532  2.609 

0.47  0.0235 2.369 2.448 2.527 2.606  2.685 

0.48  0.024  2.439 2.520 2.602 2.683  2.764 

0.49  0.0245 2.514 2.598 2.682 2.766  2.849 

0.50  0.025  2.592 2.678 2.765 2.851  2.938 
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0.51  0.0255 2.673 2.762 2.851 2.940  3.029 

0.52  0.026  2.761 2.853 2.945 3.037  3.129 

0.53  0.0265 2.852 2.947 3.042 3.138  3.233 

0.54  0.027  2.946 3.044 3.143 3.241  3.339 

0.55  0.0275 3.048 3.150 3.251 3.353  3.455 

 

Table:  KI  value for ௕ 
௪

 ratio from 3.0  to 3.4  for numerical method 

a/w  a  3 3.1 3.2 3.3  3.4

0.45  0.0225 2.4296 2.5103 2.5910 2.6716  2.7523

0.46  0.0230 2.4976 2.5811 2.6641 2.7470  2.8300

0.47  0.0235 2.5694 2.6554 2.7408 2.8261  2.9115

0.48  0.0240 2.6448 2.7333 2.8212 2.9090  2.9970

0.49  0.0245 2.7240 2.8152 2.9058 2.9963  3.0869

0.50  0.0250 2.8074 2.9013 2.9947 3.0880  3.1815

0.51  0.0255 2.8953 2.9922 3.0886 3.1848  3.2810

0.52  0.0260 2.9880 3.0881 3.1876 3.2869  3.3865

0.53  0.0265 3.0861 3.1895 3.2923 3.3950  3.4978

0.54  0.0270 3.1896 3.2966 3.4029 3.5090  3.6154

0.55  0.0275 3.2997 3.4104 3.5204 3.6303  3.7404
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Table:  KI  value for ஻ 
ௐ

 ratio from 3.5  to 4.0  for empirical method 

a/w  A (m)  3.5 3.6 3.7 3.8 3.9  4.0

0.45  0.0225  2.6108 2.6854 2.7600 2.8346 2.9092  2.9838

0.46  0.0230  2.6860 2.7627 2.8394 2.9162 2.9929  3.0697

0.47  0.0235  2.7642 2.8432 2.9222 3.0012 3.0801  3.1591

0.48  0.0240  2.8456 2.9269 3.0082 3.0895 3.1708  3.2521

0.49  0.0245  2.9333 3.0171 3.1009 3.1847 3.2685  3.3523

0.50  0.0250  3.0241 3.1105 3.1969 3.2833 3.3697  3.4561

0.51  0.0255  3.1180 3.2071 3.2961 3.3852 3.4743  3.5634

0.52  0.0260  3.2213 3.3133 3.4054 3.4974 3.5894  3.6815

0.53  0.0265  3.3277 3.4228 3.5179 3.6129 3.7080  3.8031

0.54  0.0270  3.4373 3.5355 3.6337 3.7319 3.8301  3.9263

0.55  0.0275  3.5562 3.6578 3.7595 3.8611 3.9627  4.0643

 

Table:  KI  value for ஻
ௐ

 ratio from 3.5  to 4.0  for numerical method 

a/w  A (m)  3.5 3.6 3.7 3.8 3.9  4

0.45  0.0225  2.8330 2.9137 2.9944 3.0751 3.1557  3.2366

0.46  0.0230  2.9130 2.9960 3.0789 3.1620 3.2449  3.3281

0.47  0.0235  2.9969 3.0823 3.1676 3.2531 3.3385  3.4240

0.48  0.0240  3.0849 3.1756 3.2607 3.3488 3.4366  3.5247

0.49  0.0245  3.1775 3.2681 3.3586 3.4493 3.5398  3.6306

0.50  0.0250  3.2748 3.3683 3.4616 3.5551 3.6484  3.7419
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0.51  0.0255  3.3775 3.4739 3.5702 3.6666 3.7629  3.8594

0.52  0.0260  3.4859 3.5854 3.6848 3.7844 3.8838  3.9834

0.53  0.0265  3.6006 3.7034 3.8060 3.9089 4.0116  4.1146

0.54  0.0270  3.7216 3.8279 3.9341 4.0405 4.1467  4.2531

0.55  0.0275  3.8503 3.9603 4.0702 4.1803 4.2902  4.4004

 

 


